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UNIT-1: Digital Photography
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1.4: Technology of Photography
1.5: Camera and lenses
1.6: Techniques of photography
1.7: Composition
1.8: Types of shots
1.9: Lighting
1.10: Check your Progress

1.1: Learning Objectives
After going through this unit the learners would be able to understand:
●
●
●
●

About the photography.
The various composition & lighting techniques for better photography.
The difference between film and digital photography.
Different lighting patterns

1.2: What is “Photography”?
The term photography means the science and practice of creating long
lasting images by recording light or other electromagnetic radiation. This could be
done electronically with help of an image sensor, or chemically by means of a lightsensitive material such as photographic film.
Basically, a lens is used to focus the light reflected or emitted from objects onto a
light-sensitive surface inside a camera with a timed exposure. When an electronic
image sensor is used, it produces an electrical charge, which is electronically
processed and stored in a digital image file for subsequent display or processing. In
case of light sensitive films the image is captured as hidden image which is then
further developed by chemical process to get the visible image. A negative image on
film is traditionally used to photographically create a positive image on a paper base,
known as a print, either by using an enlarger or by contact printing.
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1.3: Overview of photography
The discovery of photography started with the principle of camera obscura.
The camera obscura was first used in ancient China. Leonardo da Vinci discovered
that natural camera obscura is formed by dark caves on the edge of a sunlit valley. A
hole in the cave wall acts as a pinhole camera which allows light to project a laterally
reversed, upside down image on a piece of paper. So means of photography then
evolved with inventing means to capture and keep the image produced by the
camera, mirrors, lenses, telescopes, microscopes, etc. and natural objects and
phenomena, such as the human eye or water.
Around the year 1800, the first attempt to capture image on any light sensitive
substance was made by British inventor Thomas Wedgwood with a camera
obscura. He used paper or white leather treated with silver nitrate. Around 1802 it
was found that "the images formed by means of a camera obscura have been found
too faint to produce, in any moderate time, an effect upon the nitrate of silver." The
shadow images eventually darkened all over.

Title-Fig 3.1 Camera Obscura/Pin-hole Camera
Attribution- King James
Source- prezi.com
Link- https://prezi.com/1fluj_abvwsv/camera-obscura-pinhole-cameras/
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1.4: Technology of Photography
The most widely used photographic process is the black-and-white negative–positive
system. When light is projected with the help of camera, the lens projects an image of
the scene being photographed onto a film coated which is covered with lightsensitive silver salts, such as silver bromide. The camera shutter allows light reflected
from the scene for a given time to produce an invisible but developable image in the
sensitized layer, thus exposing the film.
While the development process (in a darkroom) the silver salt crystals that have been
struck by the light are converted into metallic silver, forming a visible deposit or
density. The more light that reaches a given area of the film, the more silver salt is
converted into black portion which marks the exposed area and the denser the silver
deposit that is formed there. An image of various brightness levels thus yields a
picture in which this brightness are tonally reversed—a negative. The brighter the
subject its details will be recorded as dark or dense areas in the developed film and
the portions which are not so bright or don’t reflect much light will be marked as light
portion.
Once the film is developed the film is treated with a fixing bath that dissolves away
all undeveloped silver salt and so prevents subsequent darkening of such unexposed
areas. After these process when all the silver salts are washed away the invisible
image becomes visible as a permanent negative silver image within the gelatine layer.
A positive picture is obtained when this negative image is again exposed through
light by the help of a device called Enlarger onto a light sensitive paper. As in case of
exposure of films the paper also when gets exposed creates a latent image. This image
can be further developed through chemical process to achieve the final image. In
contact printing the negative film and the paper are placed face to face
in intimatecontact and exposed by diffused light shining through the negative. The
dense (black) portions of the negative image result in little exposure of the paper and,
so, yield light image areas; thin portions of the negative let through more light and
yield dark areas in the print, thus re-creating the light values of the original scene.
Whereas in digital photography the principle is almost the same but the light
sensitive film is replaced by light sensitive electronic sensors also called CCD (charge
coupled device). The light rays fall on these CCD and the CCD creates an electronic
signal which is recorded on a storing device as image.

1.5: Camera and lenses
To gain the knowledge about photography we have to firstly be familiar with the
main device needed for photography i.e. the camera.
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In its simplest form, the camera is a light-tight container carrying a lens, a shutter, a
diaphragm, a device for holding (and changing) the film in the correct image plane,
and a viewfinder to allow the camera to be aimed at the desired scene.

Title- Fig 3.2 Parts of a Camera
Link-https://sites.google.com/site/tyshonharrisphoto/photography-basics/camera-partsfunctions

The lens projects an inverted image of the scene in front of the camera onto the film
in the image plane. The image is sharp only if the film is located at a specific distance
behind the lens. This distance depends on the focal length of the lens and the distance
of the object in front of the lens. All the cameras have a mechanism to adjust the
distance between the lens and focal plane to capture near and far away objects to
create sharp images. In some cameras focusing adjustment is achieved by moving
only the front element or internal elements of the lens, in effect modifying the focal
length.
The shutter consists of a set of metallic leaves mounted in or behind the lens or a
system of blinds positioned in front of the film. The shutter is made to be open and
close for a desired time to expose the film to the image formed by the lens according
to the availability of light. The amount of light can be controlled by two things that
are the timing and speed of shutter and second is the aperture which is the amount of
opening of the lens diaphragm. The diameter of the aperture is adjustable. The
combination of the diaphragm opening and exposure time is the photographic
exposure. To obtain a film image that faithfully records all the tone gradation of the
object, this exposure must be matched to the brightness (luminance) of the subject
and to the sensitivity or speed of the film. Light meters built into most modern
cameras measure the subject luminance and set the shutter or the lens diaphragm to
yield a correctly exposed image.
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Focal plane
The focal plane of a camera is the region inside the camera where the lens converge
the entire light ray to create an image. The point where a sharp image is created is
called the focal point. It is the point where the film roll or the CCD is located.

Title- Fig 3.4 Focal Plane
Link- http://astronomy.swin.edu.au/cosmos/F/Focal+Plane

Viewfinder
The viewfinder is a small lens located above the focal point. It helps the photographer
to see through and compose the frame. Whatever is seen through the viewfinder will
be captured on the film.

Title- Fig 3.5 Viewfinder of a Camera,
Attribution- Bladeor,
Source- wikimedia.org,
Link- https://commons.wikimedia.org/wiki/File:Nikon_D90_Viewfinder.JPG
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Lens
The lens is the main and inseparable part of a camera. The lens is a transparent piece
of glass which has the ability to bend light ray to create an image on a plane.
There are two types of lens; convex and concave lens.
Convex lens
A convex lens is a converging lens. When parallel rays of light pass through a convex
lens the refracted rays converge at one point called the principal focus. The distance
between the principal focus and the centre of the lens is called the focal length.

Title- Fig 3.6 Convex Lens
Attribution- Chetvorno
Source- wikimedia.org
Link- https://commons.wikimedia.org/wiki/File:Convex_lens_-_perfect.svg

Concave lens
Concave lenses are thinner at the middle. Rays of light that pass through the lens are
spread out (they diverge). A concave lens is a diverging lens. When parallel rays of
light pass through a concavelens the refracted rays diverge so that they appear to
come from one point called the principal focus.

Title- Fig 3.7 Concave Lens
Attribution- Kvr.lohith
Source- wikimedia.org
Linkhttps://commons.wikimedia.org/
wiki/File:Concave_lensdiverging_rays.png
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Camera lenses are made with a wide range of focal lengths. They range from
extreme wide angle to extreme close magnification. Each lens is designed to suit a
certain type of photography. The extreme wide angle may be preferred
for architecture because it has the capacity to capture a wide view of a building. The
normal lens which mostly has a wide aperture is often used for street
and documentary photography. The telephoto lens is useful for sports and wildlife but
it is more susceptible to camera shake. The camera lens serves a dual purpose of
focussing and zooming/ magnification of a subject.
A camera lens can be made up of one or more lenses according to the need. The lens
which are made up of only type of lens either convex or concave are called block
lens. The lens which contains more than one lens is called telephoto lens. It mostly
contains two or more convex and concave lenses.

Title- Fig 3.8 Camera Lens
Attribution- Multimotyl
Source- wikimedia.org
Link- https://commons.wikimedia.org/wiki/File:24mm-Fixed-focal-SLR-lens.jpg

A camera lens also contains a mechanism to control the amount of light entering through
the lens and falling on the film plane. This mechanism or opening is called aperture. The
aperture is denoted as “f” and it is counted in stops. Every stop is a next multiple of the
previous. The aperture opening starts from f/1.4 then f/2 likewise f/2.8, f/4 and up to f/22.
The smaller the stop the bigger the opening and the more the amount of light will be
passed through.
Title- Fig 3.9 Aperture in a camera
Source- pixabay.com
Link- https://www.pexels.com/photo/apertureart-blur-camera-414781/

Shutter
In camera, a shutter is a device that allows light to pass for a determined period for
exposing photographic film or a light-sensitive electronic sensor in order to capture a
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permanent image of a scene. But in case of projector, shutter can also be used to
allow rays of light to pass outwards to project images. A shutter of variable speed is
used to control exposure time of the film. The shutter is so constructed that it
automatically closes after a certain required time interval. The speed of the shutter is
controlled by a ring outside the camera, on which various timings are marked.
The shutter speed determines the time for which the amount of light will pass through
lens and fall on the film plane. The shutter speed varies according to what amount of one
second they open and close.
The shutter speeds are denoted as 1/250, 1/500, 1/1000. These indicate that the shutter
plate opens and close within 1000th of a second and else wise.
If one wants that the shutter should be remain open for as much time he wants he can
click and hold the shutter button as long he wants. Nowadays self-click cameras are also
available which are timed for the desired timing and the camera will do the rest.

1.6: Techniques of photography
Photography is not just point and shoots. There are many principles and techniques
which should be followed and included through regular experimentation to achieve a
breathtaking and perfect photograph.

High Speed Photography
High speed photography is the technique of capturing highly speed moving object so
that it could be seen by the human eye. Mostly subjects like bullet or a speed moving
vehicle can be captured using this technique. For this the highest possible shutter
speed available in a camera is used. It could vary from 1/1000 to 1/4000.
Title- Fig 3.10 High speed photography
AttributionSource- elakiri.com
Linkhttp://www.elakiri.com/forum/showthread.php?t=
1594950

Motion-blur Photography
Motion blur is the art of capturing a moving subject. This technique is often used in
sports photography, but can also be used to create interesting images with light or fast
moving objects. The background gets blurred but the main subject looks like frozen in
time. To create motion blur effect, slowing down the shutter speed and holding the
camera still while panning the camera from the opposite direction of the subject
motion would result perfectly timed picture.
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Title- Fig 3.11 Motion-blur photography
Attribution- E01
Source- wikimedia.org
Link- https://commons.wikimedia.org/wiki/File:London_bus_and_telephone_box_on_Haymarket.jpg

Macro Photography
When we photograph something very small we call it macro photography. Shooting
small things poses great challenges and comes with high rewards. When we talk
about macro photography we tend to think about small things that we shoot from a
close distance.
Macro photography is extreme close-up photography, usually of very small subjects
and living organisms like insects, in which the size of the subject in the photograph is
greater than life size according to some definitions, a macro photograph is one in
which the size of the subject on the negative or image sensor is life size or
greater. However, in other uses it refers to a finished photograph of a subject at
greater than life size.

Title- Fig 3.12 Macro Photography
Attribution- Endervale
Source- pixabay.com
Linkhttps://commons.wikimedia.org/wiki/Category:Macro_photog
raphy#/media/File:Aphaenogaster_spinosa_testa.jpg
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Long exposure photography
Long exposure photography as the name suggests is technique of photography by
using longer exposure times than needed to obtain a correctly exposed photograph,
either during daytime deliberate intent to create an effect on any moving object that is
typical for long exposure photographs. Effects like blurred skies with streaks of
clouds, smoothed out water like if it was frozen, blurred ghostlike people, star trails,
moon trails and light trails can be achieved by this technique.
Not only the duration of the exposure that qualifies it as a long exposure photograph,
but also when intentionally capturing moving objects with longer exposure times than
necessary that makes it a long exposure photograph.

Title- Fig 3.13 Long Exposure Photography
Attribution- Diego Delso
Source- pixabay.com
Link-https://commons.wikimedia.org/wiki/File:R%C3%ADo_Moscova,_Mosc%C3%BA,_Rusia,_2016-1003,_DD_16-17_HDR.jpg

1.7: Composition
Composition, the act of composing the image through viewfinder, is a visual
process of organizing the elements and individual details of a scene into a balanced
and pleasing arrangement. Because what one person finds pleasing, someone else will
not, composition is largely a matter of personal taste.
In simple words, composition is including what and how much of the elements in a
frame so that the photograph appears attractive or meaningful.
A photograph is mostly rectangular in shape in the ratio of 4:3 as it is believed that
the area covered by our naked eye is rectangular. So the frame in the camera is also
meant to be rectangular. So when composing a subject we have to include what we
want to shoot and how much we want to shoot within that frame. While shooting we
can just compose whatever is in front of us with just looking at the viewfinder and
Odisha State Open University, Sambalpur

10

making the desired frame or else we can arrange other elements if it is a staged
photography in the way we want to create the composition we want.
There are some basic rules of composition which we have to keep in mind which can
help us creating good photographs.

Rule of thirds
The rule of thirds is one of the most useful composition techniques in photography.
It's an important concept to learn as it can be used in all types of photography to
produce images which are more engaging and better balanced.
The rule of thirds involves mentally dividing up your image using 2 horizontal lines
and 2 vertical lines, as shown below. You then position the important elements in
your scene along those lines, or at the points where they meet.

Title- Fig 3.14 Composition Rule: Rule of Third
Attribution- Clngre~commonswiki
Source- wikimedia.org
Link- https://commons.wikimedia.org/wiki/File:Rule_of_thirds.jpg

When framing a photo, imagine the scene divided up as above. Think about what
elements of the photo are most important, and try to position them at or near the lines
and intersections of the grid. They don't have to be perfectly lined up as long as
they're close.
You may need to move around to get the best composition. This forces you to think
more carefully about the shot, and is a good habit to get into whether you're using the
rule of thirds or not. But it is advisable to keep the main part of the composition in the
centre of the grid which is called the golden rectangle. The human eye tends to look
at the centre first.
To help you out, some cameras have a setting which overlays a rule of thirds grid
onto your photo. This removes all guesswork and helps you get you’re positioning
even more accurate.
Odisha State Open University, Sambalpur
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Balancing of elements
Placing your main subject off-centre, as with the rule of thirds, creates a more
interesting photo, but it can leave a void in the scene which can make it feel empty.
You should balance the "weight" of your subject by including another object of lesser
importance to fill the space.

Symmetry and patterns
We are surrounded by symmetry and patterns, both natural and man-made. They can
make for very eye-catching compositions, particularly in situations where they are not
expected. Another great way to use them is to break the symmetry or pattern in some
way, introducing tension and a focal point to the scene. Keeping proper balance in the
pattern is very necessary.

Depth
Because photography is a two-dimensional medium, we have to choose our
composition carefully to convey the sense of depth that was present in the actual
scene. You can create depth in a photo by including objects in the foreground, middle
ground and background. Another useful composition technique is overlapping, where
you deliberately partially obscure one object with another. The human eye naturally
recognises these layers and mentally separates them out, creating an image with more
depth.

1.8: Types of Shots
Every photograph or photographic composition is called a shot. But each shot cannot
be same all the time. It would vary depending upon the mood of the photographer and
the availability of the subject.
So the composition or framings are divided into various types of shots which deliver
different kind of mood and information.

Extreme long shot
An extreme long shot (ELS) is also known as extreme wide shot. It covers a very wide
area which shows the whole figure of the subject as well as its surroundings. It also
provides a context for the scene, which means the viewer could locate where the
subject is placed. Very less detail about the subject is available in this type of shot.
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Title- Fig 3.19 Extreme long shot photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types

Long shot
A long shot (LS) also known as full shot is closer to the subject than the ELS. It
frames the whole figure of the subject. A smaller portion of the surrounding is seen in
context to the subject. The point of focus is the main subject. This type of shot
catches the action rather than the emotion.

Title- Fig 3.20 Long Shot Photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types
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Medium long shot
Medium Long Shot (MLS) is alsoknown as a three-quarters shot. While shooting a
person it frames the subject from head to knee. It is just in between composition of
long shot and medium shot.

Title- Fig 3.21 Medium Long Shot Photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types

Medium shot
Medium shot (MS) also known as mid shot is a camera shot
in which the subject is in the middle distance, permittingsome of the background to b
e seen. In this shot both emotion and action of the subject can be captured.

Title- Fig 3.22 Medium Shot Photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types

Odisha State Open University, Sambalpur

14

Medium close shot
Medium close covers the subject from head and cuts off around mid-chest. The focus
is on the subject. It reveals only little of the surroundings. It focuses the facial
expressions of the subject.

Title- Fig 3.23 Medium Close Shot Photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types

Close Shot
Close shot (CS) frames a subject's face and cuts off mid-neck, showing the face and
entire head. The subject fills almost the entire frame. It captures facial expressions
and emotions.

Title- Fig 3.24 Close Shot Photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types
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Extreme Close Shot
Extreme close shot frames only some part of the subject which photographer wants to
shoot very closely. In case of person or animal it maybe only the eyes, ears or lips etc.
mostly only the strong emotions are captured in this shot.

Title- Fig 3.25 Extreme Close Shot Photograph
Attribution- Justin Dise
Source- bhphotovideo.com
Link-https://www.bhphotovideo.com/explora/video/tips-and-solutions/filmmaking-101-camera-shot-types

1.9: Lighting
Lighting is an essential tool for enhancing the video image. The subtle use of light
creates atmosphere and mood, dimension, and texture. It can help to convey a plot
line, enhance key elements such as set color or skin tone, and signals the difference
between comedy and drama, reality and fantasy.
The subject in a planned shoot can be lit up using various lighting techniques to
achieve desirable result. In this section we will discuss about these lighting
techniques.

Odisha State Open University, Sambalpur

16

Title- Fig 3.26 Types of Lighting
Attribution- Theonlysilentbob,
Source- wikimedia.org
Link- https://commons.wikimedia.org/wiki/File:3_point_lighting.svg

Lighting, as with nearly every other aspect of Film & TV, is an essential part of the
filmmaking process. Light can sculpt and describe a scene or character, it can hide or
reveal key areas of your frame, and it can enhance suspense & evoke emotion. It is as
critical in directing the audiences’ attention or influencing their emotions as camera
movement, acting, music and editing. Ignore it at your own loss.
Key light
The key light is considered as the foremost important light that
a photographer, cinematographer, lighting cameraman, or other scene composer will
use in a lighting setup. The purpose of the key light is to highlight the form and
dimension of the subject. The key light is always not a necessary; without the key
light we can get a silhouette effect. Many key lights may be placed in a scene to
illuminate a moving subject at opportune moments.
The key light can be "hard" (focused) or "soft" (diffused), and depending on the
desired setup can be placed at different angles relative to the subject. When part of the
most common setup—three-point lighting—the key light is placed at a 30–60° angle
(with the camera marking 0 degrees). In addition to the horizontal angle, the key light
can be placed high or low producing different effects. The most common vertical
position for the key light is at a 30° angle (i.e. slightly above the eye line; the nose
should not cast a shadow on the lips).
Odisha State Open University, Sambalpur
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A key light positioned low appears to distort the actor's features, since most natural
or ambient light is normally overhead. A dramatic effect used in horror or
comedy cinematography is a key light illuminating the face from below. A high key
light will result in more prominent cheek bones and long nose shadows.
In many cases, the key light is a stage light for indoor scenes, or sunlight for
outdoors. A lighting instrument may also be used outdoors to supplement sunlight or
as the primary light source with sunlight or skylight serving as fill lighting.
Actual lamps, lighting fixtures, can serve as key lights, provided they are of sufficient
brightness. They may also appear within the scene as props — in which case they are
called "practical’s." Similarly, fire, candles and other natural sources of light can be
used.
The key light can be divided into various categories as discussed below.
Flat lighting: The first key (or primary/main) common lighting pattern that you
should be familiar with is flat lighting. Flat lighting faces directly into the subject
from the angle of the lens. Flat lighting is the least dramatic lighting pattern because it
casts the least amount of shadows on the subject’s face.

Title- Types of Lighting: Flat Key Light
Attribution- Darlene Hildebrandt
SourceLink- https://digital-photography-school.com/6-portrait-lighting-patterns-every-photographer-should-know/
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Butterfly lighting: Butterfly Lighting (or Paramount Lighting) comes directly in
front and above the subject’s face. This creates shadows that are directly below the
subject’s facial features. The most notable shadow, and where this lighting pattern
gets its name, is a butterfly shaped shadow just under the nose. It is also called
“Paramount Lighting” because this lighting pattern was used heavily in the
Paramount movie studio of old Hollywood.
The only difference between flat lighting and butterfly lighting is the height and angle
of the Key Light. This creates the same flattering features as flat lighting but includes
shadows underneath the nose and chin.

Title- Types of Lighting: Butterfly Lighting
Attribution- Darlene Hildebrandt
SourceLink- https://digital-photography-school.com/6-portrait-lighting-patterns-every-photographer-should-know/

Loop lighting:Loop lighting is probably one of the most common key lighting
patterns. We see that it falls right in the middle between flattering flat light to
dramatic split light. Loop Light is such a condition, where most of the face is still in
light but you still have enough shadows to bring in some definition. It brings out a
three dimensional effect of the subject.

Title- Types of Lighting: Loop Lighting
Attribution- Darlene Hildebrandt
SourceLink- https://digital-photography-school.com/6-portrait-lighting-patternsevery-photographer-should-know/
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Split lighting:Split lighting simply “splits” the subject’s face, lighting half of your
subject’s face while leaving the other half in shadow. Because of the angle of light,
there is no Rembrandt triangle, only shadow.
When the key light is set up 90° directly, to the right or left side of the subject’s face.
The line separating light and shadow will be down the middle of the nose and chin.
This creates the most dramatic light and the least flattering light to use.
Half-light:half-light is a condition of portrait photography when the subject is half
illuminated and half in shadow. The light is hold in such a manner that only half of
the subject is lighted. This creates a very magical effect.
Fill Light: As per the name it is used to fill a gap of light and darkness. If there is a
contrast of dark and over exposed portions on the subject, then a soft light can be
used to supply a little amount of exposure on the subject. It thus fills the gap and
subject looks normal to the eye. The amount of fill light can be used as per the
resolution of recording medium.
The most common source of natural omnidirectional fill light is the sunlight. It is
mostly used while shooting outdoor. A fill light is used against the axis of the direct
light. Hence it cuts off any hard shadows created by the direct light upon the subject.
The positioning of the fill affects the overall appearance of the lighting pattern. When
a centred fill strategy is used the ratio is created by overlapping the key light over the
foundation of fill. A key source of equal incident intensity to the fill, overlapping the
even fill, will create a 2:1 reflected ratio (1 key + 1 fill over 1 Fill) = 2:1.
Back Light: While studying about the lighting design, backlighting is the process
of illuminating the subject from the back. In other words, the lighting instrument and
the viewer face each other, with the subject in between. The viewer can see the source
of light from behind the subject. This creates a glowing effect on the edges of the
subject, while other areas are darker. The backlight can be a natural or artificial
source of light. While using artificial source, the back light is usually placed directly
behind the subject in a 4-point lighting setup.
The back light is sometimes called hair or shoulder light, as it helps make the edges
the subject's hair glow if the hair is fuzzy. This can create an angelic halo type effect
around the head. Television productions often use this effect in soap operas.
Ambient Lighting: Ambient light means the light that is already present in a scene,
before any additional lighting is added. It usually refers to natural light, either
outdoors or coming through windows etc. It can also mean artificial lights such as
normal room lights.
Odisha State Open University, Sambalpur
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Ambient light can be the photographer's friend and/or enemy. Clearly ambient light is
important in photography and video work, as most shots rely largely or wholly on
ambient lighting.
Unfortunately ambient light can be a real nuisance if it conflicts with what the
photographer wants to achieve. For example, ambient light may be the wrong colour
temperature, intensity or direction for the desired effect. In this case the photographer
may choose to block out the ambient light completely and replace it with artificial
light. Of course this isn't always practical and sometime compromises must be made.
On the other hand, many of history's greatest photographs and film shots have relied
on interesting ambient light. Unusual lighting can turn an otherwise ordinary shot into
something very powerful.
Motivated Lighting: The light in a scene which appears to have a source such as a
window, a lamp, a fireplace, so on. In some cases the light will come from a source
visible in the scene and in some cases, it will only appear to come from a source that
is visible in the scene.

1.10: Check your Progress
1. Difference between convex and concave lens.

---------------------------------------------------------------------------------------------------------------------------------------------------------------------2. Discuss different rules of composition.

---------------------------------------------------------------------------------------------------------------------------------------------------------------------3. How close shot is different from extreme close shot?

----------------------------------------------------------------------------------------------------------------------------------------------------------------------
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Unit-2: Selection of Photograpgh
2.0: Unit Structure
2.1: Learning Objectives
2.2: Criteria for selecting photos
2.3: What makes a strong news picture?
2.4: Types of News Picture
2.5: Concept of Photo Editing
2.6: Ethics in Photo Editing
2.7: Check your progress

2.1: Learning Objectives
In this unit students will able to;
- Know about the important part of selection of photos
- Know the criteria of selecting news photographs
- Acquire the points of photo manipulation etc.

2.2: Criteria for selecting photos
Finding photos: Many graphic artists rely on professional photojournalists, either as
their staff or freelancers, to provide quality images that fit needs of specific
publications.
The selection of ‘good’ pictures has increasingly become a crucial factor when
transmitting news to the recipients. Every day thousands of events are happening and
millions of pictures are taken. By choosing photographs for newspapers and
magazines, photographic editorial departments want to attract the recipients' attention,
evoke emotions and get them to read their stories. But what exactly is a good picture
that meets these expectations? Which criteria are decisive for selecting pictures and
what effects of this selection can be measured on the recipients' side?
Five steps for photo selection1) The selection of news by news editors
2) The search for visuals matching the news by photo editors
3) The selection of visuals by photo editors based on criteria of 'what' is
pictured, 'how' it is pictured and eventually 'why' it is relevant
4) Checking its values
5) Shortlisting for the relevant page
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Some general rules for choosing photos for media publication, favor photos of
people doing thingsWhat to avoid?
-

Avoid sunsets and scenery.
Avoid people just standing there posing for the camera.
Avoid pictures of things, unless illustrations for a story.

Specific considerations1. Picture quality-Discard out of focus photos. Dark photos will look even darker in
print. Photos should be slightly more contrasting than usual.
2. Some flaws-Photos taken with flash on camera, if it's obvious, generally should be
rejected. Photos without idents are seldom printed, except in advertisements. Photos
used for any purpose but editorial (journalism) must have model release.
3. Things to avoid-You can't download photos from the net for print without
permission. "Royalty free" photo sites don't necessarily mean "free." Lots of free
photos are available on the net, but much of it looks too generic for professional use.
4. Cropping- Nearly all media photos will need some cropping, either by the
photographer, the picture editor, the art director or the graphic artist. Avoid large
expanses of empty space, such as skies, pavement, clouds, ceilings, floors, unless
clearly enhances photo.
Crop fairly tightly around people, but not so tightly it removes necessary context.
Avoid cropping in between a joint, such as lower leg, middle of finger because it
looks awkward.Leave a little space above head, so subject doesn't appear to be drawn
to the edge of the photo.
5. Retouching-Ethics vary depending on purpose of photo. Generally it is unethical
to retouch journalism photos, even to clean up skin blemishes. You cannot ethically
remover or add people to photos, or change backgrounds--unless for advertising.
6. Printing- All photos must have cutlines for media publication. Mugshots can have
just the person's name. Full name must be used. It is not the graphic artist's job to
write cutlines, but sometimes you have to.
Be very careful before considering transposing a photo to face the other direction.

2.3: What makes a strong news picture?
A strong news picture has to be about the news. That is, it has to be about something
which is new, unusual, interesting, and significant and about people. To that extent, it
is no different from a news story. However, news pictures also need three other
qualities:
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1.Life-To the photographer, a picture assignment may seem dull. It may just seem
like yet another cheque presentation, or yet another graduation day, or yet another
retirement.
To the people involved in the story, though, each of these is a big event - the
culmination of months of fund-raising, the fruit of years of study or the end of a
lifetime's service. It is the news photographer's job to feel the same excitement which
the people involved in the story feel, and to convey that through the picture to the
readers.
2. Relevant context- A photograph of a man behind a desk tells us nothing, and no
newspaper should ever publish such a picture.
Some people sit behind desks because they are business people, running companies
which produce soft drinks - photograph them in the factory, surrounded by bottles of
soft drink.
However, a photograph of the teacher painting, surrounded by the students, might be
the complete news picture.
In the case on the right, the man is an editor, so show him doing something special to
his job.
3. Meaning- Every news picture must earn its space on the page. That means that it
must tell the story clearly, without needing people to read the story first in order to
understand what the picture is all about. In other words, every news picture must have
meaning.
A picture of a man pointing at a broken window means nothing. If this is a man
whose house has been broken into, by the thieves breaking a window and climbing in,
then the story is about the way he feels, as well as the damage done. The picture
should show his anger, or distress, in his expression and gestures; behind him and to
one side can be the broken window; all around him may be the mess which the
thieves left behind. In this way the picture can have meaning to the reader.

2.4: Types of news picture
Some news pictures will fit into more than one category - a portrait of a
person may well be humorous, for example. And there will always be good
photographers who can produce good pictures which book authors cannot fit into any
category at all. That is what makes journalism so interesting.
The happening
There are all sorts of news stories, but the big news is the thing which just happened.
Perhaps there was an unusual act of nature - an earthquake, a cyclone, an eclipse of
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the sun. Perhaps there was a man-made drama - a murder, a robbery, a demonstration,
a parade. Whatever happened, it was new; and if it was unusual and interesting, then
it was news. A photograph of it is just what a newspaper editor wants.
A photograph of a happening helps the readers in many ways. It provides proof that
the event really happened, since the readers can see it with their own eyes. It also
takes the readers there, and lets them see the setting in which the event happened. In
this way, it helps the words to tell the story, by making clear what they mean.
The epitome
An epitome is something which shows, on a small scale, exactly what something
larger is like. For example, a photograph of one student with her head buried in a
book might epitomise all the excessive burden of studies bore by all students, and
could be a strong, telling and reflective news picture as the time of national
examinations comes near.
People
News is about people. It is about things which people do, and things which happen to
people. To tell the news, we need to let the readers know who those people are and
what they are like.
A picture can do this, if it shows the person's character and the person's context. If the
news story is about a man's house being burned down, then we do not want a picture
of him smiling: he needs to look sad. He needs to be photographed either in the
burned remains of his house, or on the beach where he has to sleep now, or in
whatever other context tells the story.
Revelations
Most of our readers see only a few places and meet only a few people in their
everyday lives. They do not see a lot of what goes on around them, because it
happens in places which they never visit.
There are many other things which most of our readers do not see because they do not
want to see them, even though they may be happening in places which they visit
regularly - beggars on the street, people looking in rubbish bins to find food,
pickpockets and car thieves.
It is part of the job of all the news media to reveal to their readers or listeners what
their society is like, and newspapers in particular can publish pictures which force
people to see clearly the society they live in.
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These pictures may show that crime is committed, that some people live in poor
conditions in squatter settlements or shanty towns, that there is social injustice, that
there is fighting going on between rival clans in remote parts of the country.
Not all revelations need to be negative, though. It is just as valuable to make your
readers look for the first time at the life of a person or a family which overcomes
difficulties - perhaps dealing with physical handicap, or finding ways to make money
when there are no jobs available, or getting on with life while tribal fighting is going
on all around.
Humour
A newspaper without a sense of humour is missing out on an important part of life.
People enjoy a joke, and they will like a newspaper more if it can see the funny side
of life as well as the serious side.
Pictures can often be funny by bringing together things which are not usually seen
together, or by using contrasts of extreme sizes.
More than one picture
If you get back to the office, and find that the one picture you have taken does not
really tell the story, it is too late to do anything about it. You cannot gather everybody
together again for another attempt.
So when you are sent to cover a story, and when it has picture possibilities, you
should always take more than one picture.
In the first place, cameras can be held in two ways to take both horizontal and vertical
pictures. You should always take at least one picture of each shape.
You should also come up with more than one picture idea, in case one of them does
not really work. That means thinking in advance about the story, and imagining what
the finished picture could look like.
Sequences
A sequence of pictures can show a story unfolding, and therefore tell that story better
than a single image can do. Very often, the editor will want to use the last picture like
the punchline of a joke, using it bigger than the rest, so that the early pictures give the
background to the main news, which is shown in the final climax picture. Be prepared
when news is happening in front of you to keep taking one picture after another, in
rapid succession, so that you may have a good sequence.
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In any case, whether you have used only one frame or 30, the photos must be
developed or downloaded as soon as you return to the newsroom. If you are using
film, it should not sit in your camera for several days, waiting for you to finish the
roll, while the news becomes old; you may as well use all the film on the current
assignment.
Big events
A big event, like an independence day or anniversary celebration, or the visit of a
foreign head of state, may well need many photographs to tell the whole story. Such
an event will probably be too diverse to be captured in one picture.
All aspects of human life are there on these big occasions, and it is the job of the
news photographer to capture them all.
And don’t forget that many big days are not happy – for example Hiroshima Day in
Japan - or may be sorrowful for some people in the society. In Australia, for example,
Australia Day signifies for many Aboriginal and Torres Strait Islanders the day their
country was colonised by the British. A spread of photos of Australia Day
celebrations would be incomplete without some showing the perspective of
indigenous people.

2.5: Concept of Photo Editing
It requires a strong eye to select a photograph or to edit it. Out of hundreds of
photos that a photographer files or shortlists, an editor picks one for publishing
purposes. He analyses the strengths and weaknesses of a photograph filed by the staff
photographers or freelancers. While some are fit for publishing, others require some
finishing touch. So a photo editor sometimes selects those pictures which have the
substances but requires some editing, which includes cropping, playing with the
contrast and brightness in the picture etc. Sometimes by cropping the important
feature of the picture gets highlighted which was earlier getting shadowed by other
elements present in the frame.
In newspapers there is a constant fight for space. Regardless of how good an
original picture is, most of the pictures undergo cropping. But cropping can be good
or bad.
While a thoughtful cropping improves the frame and makes a picture
appealing to a reader, at the same time, excess cropping or chopping off a frame
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ruthlessly ruins the picture. It fails to translate the meaning. Most of all ruins the
mood of a photojournalist the next day after the paper is published

2.6: Ethics in Photo Editing
Post production is done for effective communication. Editing is done by
selecting, cropping, and enlarging certain photographs for a bigger impact. A photo
editor may not be a photojournalist. The photo editor may crop the image, check the
white balance, check noise, remove noise, and improve sharpness. Resizing and
scaling of the images is also done in editing. It is always good to work with ‘raw’
images during editing. The image formed through the camera sensor is the
‘raw’image. Adjustments like conversion into grayscale, and normal toning and
minimal colour adjustments are acceptable as long as they restore the authentic nature
of the photograph.
Ethics
Merriam-Webster defines “ethics” as, “the code of good conduct for an individual or
group,” and lists its synonyms as, “morality, morals, principles, and standards.
In terms of ethics in photojournalism, the National Press Photographers Association's
Code ofEthics reads, in part:
Photographic and video images can reveal great truths, exposewrongdoing and
neglect, inspire hope and understandingand connect people around the globe through
the languageof visual understanding. Photographs can also causegreat harm if they
are callously intrusive or are manipulated.
Just like the news, a photograph published in the newspaper should be correct, factual
as it has to do with the reputation of the paper. The readers trust a newspaper based
on the news and photos it publishes. In case a photograph is fake or unethically taken,
it creates a mistrust in readers. As human beings, Photojournalists should follow the
same ethics as everyone else. As of the nature of Photojournalism, this leads to a lot
of discrepancies since the characteristics of documentary photography means that
photographers find themselves more often than not in areas of conflict that challenge
the ethics of photojournalism.
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In the documentary and street photography forms, any deliberate distortion by the
photographer that does not fulfil this requirement disqualifies the images. This is
called 'photo manipulation'. Here are some pointers that explain manipulation further:
1. Do not add, remove, rearrange or flip things or people in the image.
2. Do not modify colors.
3. Do not crop a picture by deleting elements.
4. Do not heighten the density, contrast or saturation for the purpose of removing
elements or people, or over-dramatize a situation.
PHOTO JOURNALISM AND ETHICS
Photojournalism provides important information to its audience. This information has
to be correct as it is important for decision making. A photojournalist has to show
whether the message in the picture is for the larger interest of the society. The
photojournalist should also respect the privacy of a person or a family which is
involved in the story. Breach of privacy and selling of pictures of a private event is
unethical. In a private party or a function it is always good to seek permission before
taking pictures. Manipulation is to be avoided. Re-enacting of events or staging of
events is seen as manipulation. Adding or deleting of images, substantial background
or pros is also counted as manipulation.

One has to be careful when taking pictures of a major tragedy like earthquake or an
explosion. Mutilated parts of human body are not to be shot and published. Human
body and its parts should not be published unless there is requirement as in case of
health story. If the publication is for public good then it may be photographed and
published. The content of a photograph must not be altered in Photoshop or by any
other means. The faces or identities of the subjects must not be altered by image
editing tools like Photoshop. Many media organizations say that the removal of “red
eye” from photographs is not acceptable. Photo editor should not manipulate images
or add in any way that misleads the viewers.
Honesty, responsibility, accuracy and truth are the backbone of photojournalism’s
code of ethics, in accordance with rights and obligations of journalists. These are
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detailed in documents such as the Charters of Munich or of the National Press
Photographers’ Association.
Preamble of the National Press Photographers Association, a professional society that
promotes the highest standards in visual journalism, acknowledges concern for every
person's need both to be fully informed about public events and to be recognized as
part of the world in which we live.
Photo journalists operate as trustees of the public. Our primary role is to report
visually on the significant events and varied viewpoints in our common world. Our
primary goal is the faithful and comprehensive depiction of the subject at hand. As
visual journalists, we have the responsibility to document society and to preserve its
history through images. Photographic and video images can reveal great truths,
expose wrongdoing and neglect, inspire hope and understanding and connect people
around the globe through the language of visual understanding. Photographs can also
cause great harm if they are callously intrusive or are manipulated. This code is
intended to promote the highest quality in all forms of visual journalism and to
strengthen public confidence in the profession. It is also meant to serve as an
educational tool both for those who practice and for those who appreciate
photojournalism
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2.7: Check Your Progress
1.

Why is editing important in photojournalism process?

------------------------------------------------------------------------------------------------------------------------------------------------------------------2. What are photojournalism ethics?

------------------------------------------------------------------------------------------------------------------------------------------------------------------3. What are the criteria of selecting pictures?

------------------------------------------------------------------------------------------------------------------------------------------------------------------4. Who selects the news photos?

-------------------------------------------------------------------------------------------------------------------------------------------------------------------
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Unit-3: Basics of Image Editing
3.0: Unit Structure
3.1: Learning Objectives
3.2: Scanning and Capturing Images
3.3: Image Editing
3.4: Colour Adjustments
3.5: Masking
3.6: Unit Summary
3.7: Check Your Progress

3.1: Learning Objectives
After learning of this unit students will be able to;
•
Describe the process of scanning i.e., transferring of paper content into
a Digital Image content using Scanners.
•
Identify the aspects of Camera.
•
Use the software used in Image Editing.
•
Practice the process of image editing.
•
Apply the process of colour correction in an image using software.
•
Explain the process of masking in a design.

3.2: Scanning and Capturing Images
Scanning is the process of transferring content in a piece of paper into digital
format. The content in the paper can be text, hand written matter, drawing, painting,
photograph etc. The device which is used to do scanning is called Scanner. It is a
device in which we place the paper on the glass and it captures the data in RGB
format of the computer.
History of Scanning
Telephotography and fax were the input devices which were used in the early
days for transmitting messages from one place to another in paper format. These
sources inspired the idea of modern scanners of today.
In the year 1860s, the historical form of facsimile machine which used to
transmit images on a telegraph line was introduced by Giovanni Casselli. It was
named Pantelegraph, which started to be used commercially for practical purposes. It
used Electromagnets which matches the movements and creates an exact replica of
the image at source. The size of the paper used to transfer was around 150 x 100 mm.
After few years, photocells were used for scanning and the data generated was
transferred using Phone lines. This process was adopted by AT&T for their wire
photo service.
This type of technique was also experimented in Europe and named Belino. The
media agencies of newspaper, T.V., Radio etc. used this system in the 90s era for
their business purpose.
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Types of Scanners
Drum Scanners

Flatbed
Scanners:

CCD Scanner

CIS Scanner

PMT Tubes i.e., Photomultiplier Tubes were used to transfer
the information using Drum Scanners. Three colours are used
to capture images i.e., Red, Green and Blue. The content is
divided into these three channels and transferred into Digital
System.
These are the scanners which are used now-a-days for
scanning paper contents. A thin light beam passes over the
content which transfers the content line wise into a Digital
Image format.
CCD (Charged couple device) scanners are made up of three
arrays or rows. They contain sensors of Red, Green and Blue
colours which are called Primary Colours.
CIS (Contact Image Sensor) also used Red, Green and Blue
LEDs for illumination purpose. For the purpose of light
collection the LEDs are connected to a monochromatic
photodiode which is placed under a Rod.

Apart from these, there are also other scanners like Film, Roller Scanner, 3D
Scanner, Planetary scanner etc. Due to the rise in technology, the types of scanners
are developing in the quality and providing excellent results.

Process of Scanning
-

“Power On” the Scanner
Insert the image in the glass bed of the scanner upside down as done in case of
a Xerox Machine.
1. Choose the Photo

[Screenshot]
3. Place the photo upside
down
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2. Open the Scanner and place the photo
upside down

[Screenshot]
4. Close the scanner

33

[Screenshot]

-

Open the software for Scanning

-

File – New Scan

-

Click on “Preview”

[Screenshot]

[Screenshot]

[Screenshot]

-

Choose the Resolution as 300 DPI [Minimum standard for good print quality]
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[Screenshot]

-

Click on “Scan”
The Process of scanning will take around a minute.

[Screenshot]

-

After the scanning is complete, it will save the image in the computer in the
default folder of scanned images.

Capturing Images
The medium of capturing images from the live scene is called Camera. It is
optical equipment which is used for clicking images and storing photographs. Today,
we have Digital Camera’s which has the capability to display the positive of the
image immediately after clicking it on its display. In today’s life almost everyone has
a camera in-built in his/her mobile.
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Canon FT camera ,135mm 1:3.5
lens of the 90’s
Title-Camera
Attribution-Alvesgaspar
Source-Wikipedia

The cameras in the beginning used Negative as the
source to store the image which is clicked. Then the
image is taken to Photo Lab where the image is
developed is a dark room. After that the positive is
derived out of it. This process takes around 2 or 3
days for the customer to get the positive of the image
taken.
The quality of the image depends upon the lens of the
camera. To achieve better results of a far distance
scene, high range lenses are mounted on the camera.
Photos and Photography has always remained a
passion for each and every human being. They feel
happy watching at the glimpses of photographs of
self and others in various moods and places.

Linkhttps://en.wikipedia.org/wiki/Camera

The excessive interest in Photography has been the
motivation to develop high end cameras with quick
functionality. This gave birth to Digital Cameras
which was a revolution in the world of Photography.
The immediate output is one of the features which
have delighted everyone. Digital camera is available
in most of the households as a part of home
accessory. It is no more a luxury, it is a part of a
daily entertainment to capture moments and make it
memories.
Digital images are stored in digital format hence it is
very easy to transfer and share images. Websites like
Facebook, whatsapp etc. have grown to a huge extent
due to its photo sharing capability.
Image stored in digital format are very durable and
do not get distorted or damaged. It remains in the
same quality in which it has been taken. It can be
stored for all the generations to come with perfect
quality.

Title-Camera front & Back
Attribution-Antoine.01
Source-gemaakt met digitalecamera
Olympus X-720

Linkhttps://commons.wikimedia.org/wik
i/File:Olympus-digitale-camera-FE130.JPG

Resolution of Capturing Images on a Camera
The resolution of Capturing an Image depends upon the Optical Zoom of the
Camera. We have also heard of 8 megapixels, 12 megapixel and 15 megapixels also.
This is the pixel size at which a shot is made. The more is the megapixels, the more is
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the size of the pixel of the image. This will help in printing the image at a bigger size
with perfect quality. This table illustrates an example of megapixels with pixel size
and image size.
Maximum Print Size
8” x 10”

Minimum Megapixels
5 Megapixels

Pixel Resolution
2560 x 1920

11” x 14”

6 Megapixels

2816 x 2112

16” x 20”

8 Megapixels

3264 x 2468

16” x 24”

12 Megapixels

4200x 2800

The latest Digital Cameras have all the capabilities to capture an image with
high quality output. It depends upon the knowledge of the user to choose and capture
images as per his requirement.

3.3: Image Editing
Images are stored in computer in a pixel format which comprises of grids. This
process of storing a Digital image is termed as Raster Graphics. It contains the
information of the position and colour of each and every pixel which combines into
an Image when displayed on computer software or any digital platform.
The images which are captured can be stored as well as edited with the help of
software’s. The images are edited to make them look better. There are automatic
settings fitted in cameras which rectifies the image and produces a bright and clear
image in dim lighted areas also. Even though the photo is dim, there are computer
software’s with options which automatically corrects the colour of the image.
The few features of images which can be edited in computer software are
described with the process.
 Selection and adjusting a particular part of an image.
In a Particular image, we can select an area using the selection tool of software
and make modifications to the selected area or delete as per our requirement.
 Open Krita
 File – Open [Open an Image]
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Title- River - Landscape
Attribution- Quangpraha (User name as per pixabay)
Source- Pixabay
Link-https://pixabay.com/en/rivers-river-the-landscape-wheel-3059562/



Rectangle Selection Tool
Select an Area

[Screenshot]

Press Delete
Select Menu - Deselect
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It will delete the selected area.

Merging two or more images via Layers
Two different images can be merged into a single image using Layers. This helps
to move the layers or remove it at any time.



Open Krita
File – Open [Open an Image]




Rectangle Selection Tool
Select an area
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[Screenshot]




Edit Menu – Copy
File – Open [Open Another Photo]

Title- Red Rocks
Attribution- esudroff (User name as per pixabay)
Source- Pixabay
Link-https://pixabay.com/en/hiking-red-rocks-valley-of-fire-3057280/




Edit Menu – Paste
It will paste the selected portion of the first image in this file. This will create
a new layer in the layers panel.
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[Screenshot]



We are resize the image using

Transform Tool

[Screenshot]



Changing the Image Size according to requirement
An image can be opened using the software and the size of the image can be
changed according to the need of the Project. However, if the size of the image is
increased the pixels of the image will get distorted. But, if the size of the image
is reduced, there will be no effect in the quality of the picture.



Open Krita
File – Open [Open an Image]



Image Menu – Scale Image to New Size
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[Screenshot]

[Screenshot]




Change the width and height as required and press OK.

Cropping of an image
There are situation when we take a photograph or scan an image, we get some portions
which seems to be not required at the edges. We can select the portion only which we
want and remove the remaining areas using the Crop Tool.
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Open Krita
File – Open [Open an Image]




Rectangle Selection Tool
Select an area



Image Menu – Trim to Selection [In some software, Crop is termed as
Trim]

[Screenshot]



The output will be as follows:
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[Screenshot]


Changing the Image Orientation

The angle of the Image can be rotated by any angle as required. We can even
Mirror the image horizontally or vertically as per our need.




Open Krita
File – Open [Open an Image]
Image Menu – Rotate


[Screenshot]





Image Menu – Mirror Image Horizontally
Image Menu – Mirror Image Vertically

Transforming, Perspective and Warping Images.
The image can be applied transformations, adjust the Perspective and Warp
Images. When we take a photograph, it may or may not fit the area in which we
want, hence, we need to manipulate the transformations i.e. Move, Rotate and
Scale the image to fit our requirement.



Open Krita
File – Open [Open an Image]





Choose the Transform tool
Tool Options –
We have the options required for editing.
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[Screenshot]



- Free



- Perspective



- Warp



- Cage






- Liquify
Choose each tool and click and drag on the specific area of the image to view
the result.

Cleaning a damaged area using Clone stamp
There are situation when we take a photograph or scan an image, we get some
portions which seems to be not required at the edges. We can select the portion
only which we want and remove the remaining areas using the Crop Tool.



Open Krita
File – Open [Open an Image with some stain marks]
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[Image Composition by the Author]
Our motive is to clean the stained areas of the Image



Choose



Brush Settings





You will be able to see a green marker
Hold Control and Click on a nice area
Leave the Control and Click on the Affected area




[Screenshot]
Repeat the process as many times as required to clean the affected area.
The output will be as follows.

Brush Tool
– Clone Tool
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[Screenshot]



Blurring the Images and Reducing Noise
There are occasions where we get noise in a photograph due to inadequate
lighting. In that case we have options in computer software to reduce the Noise
using the Blur technique




Open Krita
File – Open [Open an Image with some stain marks]
Filter Menu – Blur

[Screenshot]



Or Filter Menu – Enhance – Gaussian Noise Reduction

[Screenshot]




Any of the above two can be applied for Noise reduction.

Creating Artificial Lighting
When we take a photograph, it comes with the natural lighting of the scene.
There are some in-built capabilities in Camera like Flash etc. which can correct
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the light of the image to a certain extent. But there are cases where the default
settings of the camera output do not suit our requirement. So, we want to
increase the brightness of a particular area using the artificial lighting which can
be added using software’s. In software’s like Photoshop we have the option in
the Filter Menu – Render – Lighting Effects and Lens flare. We can manually
draw using the brush tool and create the effect of an artificial light.


Application of Filters
Photographs and images are edited and enhanced using the application of
Filters in software’s like Krita, Photoshop etc.





Open Krita
File – Open [Open an Image]
Filter Menu – Apply and Practice and all options one by one to view the
changes in the image.
The options in Filter Menu are experimental and developed by the coding
experts in a random manner to create abstract form of images. Some output
from the options can be explained in particular whereas others are creative
forms which do not have exact meanings.

3.4: Colour Adjustments
Colour Adjustment or Colour Correction is an important part of Image
Editing. When we take a photograph it comes with the default settings. But we can
enhance and change the colour settings using software’s. We can take a photograph in
day time and convert it to a theme where it would look like it has been taken in night
or a cloudy atmosphere.



Open Krita
File – Open [Open an Image]




Filter Menu – Adjust – [Options]
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All the options under the Filter Menu – Adjust will change the colour settings
of the image. The user has to apply the effects one by one and decide which
suits his requirement.

[Screenshot]




Auto Contrast – It automatically sets the contrast of the image as per the
default settings of the Software for an image.
Brightness / Contrast Curve – It will change the brightness and contrast of
the image as done in case of a Television or a Computer Monitor.

[Screenshot]

The line has to be adjusted by moving up or down for the effect.
 Burn – It will Burn the image or create a dark shade of an image.
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[Screenshot]

Shadows indicate the dark shades of an image, Midtones indicates the mid shades
of an image and Highlights indicate the bright shades of an image.
We have to select them one by one and change the Exposure. The preview icon
will display the output before pressing the OK Button. After getting satisfied with
the output one can click OK.
 Colour Balance – It will change the colour balance by changing the options.

[Screenshot]



Desaturate – It will convert the image into Black and white shade.
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[Screenshot]



Dodge – It will convert to extreme brightness or to extreme darkness.

[Screenshot]



HSV Adjustment – It is a type of colour adjustment which includes Hue,
Saturation and Value.
Hue – Hue stands for the spectrum of colours.
Saturation – Saturation stands for the colour depth from main colour to its
respective black and white shade.
Value – The change of value of the colour from its white coordinate to main
colour and back to its black coordinate.
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[Screenshot]




Invert – It will reverse the colour channels of the image hence turning the
image into a negative kind of effect.
Levels – It is used to change the lighting theme of the image.

[Screenshot]

There are three markers for adjustment1. Shadows
2. Midtones
3. Highlights


Colour Adjustment Curves– The colours can be adjusted by choosing the
Channels and the curve in the panel.
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Threshold – It will convert the colour into a Single colour mode where we
will have only black as the key colour with white background. This is done for
creating an outline sketch of an image.

[Screenshot]

[Screenshot]

3.5: Masking
Masking is the effect of placing a photo inside a particular shape. It is done
using the help of software’s like Krita, Photoshop etc. This kind of effects is basically
used in commercially done designs. In this case we see an image wrapped inside a
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Circle, Rectangle, a Love shape, Text etc. This adds to the creative design aspect of
the designer. This kind of effect appeals to the consumer or viewer.




Open any Image Editing Software.
Select the Image which you want to warp inside a mask.
Create a mask i.e. Shape, Text, Hand drawn design etc.

[Composition by Author]
 - Photo inside a Circle

[Composition by Author]
 - Photo inside a Text
There are enormous examples of this kind of masking effects in Leaflets,
brochures, catalogues etc. Any image with a different structure creates a visual appeal
in the minds of the people. They are extraordinary than a rectangle shaped image. It
conveys the message of two things at a same time. One is the Image and the other the
shape or text in which the image is display. Again these masked images are supported
by outlines, shadows etc. to create a more depth effect. It is a composition of effects
which makes an image attractive.

3.6: Unit Summary
In this Unit you have learnt about the process of converting paper content into
a digital content via scanning. You learnt some of the options related to Camera and
resolution. We came to know about the theory of Image Editing as well as the
Practical of some of the image editing using open source software Krita. You can also
do colour corrections, colour adjustments and masking of an image. These tips and
techniques will help you to use the software effectively.
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The motive of learning an image editing software has to be clear before
entering into practical. This will help in knowing the applicability of the functions of
the software in projects or commercial works.

3.7: Check Your Progress
1. What is the role of brightness and contrast in image editing?

-------------------------------------------------------------------------------------------------------------------------------------------------------2. How to clean a damaged area using Clone stamp tool?

-------------------------------------------------------------------------------------------------------------------------------------------------------3. How to edit an Image?

--------------------------------------------------------------------------------------------------------------------------------------------------------
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Unit-4: Process of Image Editing
4.0: Unit Structure
4.1: Learning Objectives
4.2: Working with Digital Camera Photos
4.3: Creating a Contrast Mask
4.4: Layer Masks
4.5: Selective Colorization Example
4.6: Basic Color Curves
4.7: Check your Progress

4.1: Learning Objectives
After completion of this unit learners will be able to;
-

Edit photographs using the advance techniques layer like blend and the
exposure tools of the Gimp.

-

Blend two different exposures of the same scene combined to get the best
parts of both images.

4.2: Working with Digital Camera photos
The Procedure
The basic technique is to create a layer above the image that contains the other
exposure of the same scene. Finally, apply a layer mask to the thin layer which makes
parts of the image transparent to shown in image below.
Step 1

Screenshot

Here are the two exposures, loaded into GIMP. Sandwich these on different layers
and then combine them with a layer mask.
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Step 2

Screenshot
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The first decision is which one goes on top. In this case the decision is to put the
lighter image on top and the darker one on the bottom. The reason is because is that
these are hand-held shots, and are far from aligned. Move the bottom image until the
arch is aligned as best.
Go the image that is going to be on the bottom. Open the Layers dialog (Ctrl+L) and click
on the new layer button ( ) to create a new layer.

Step 3

Screenshot

Go to the image that is going to be on top. Select all and copy (Ctrl+Athen Ctrl+C).
In the Layers dialog, make sure the new layer is selected, then go to the bottom image
window and paste (Ctrl+V). In the Layers dialog, click on the anchor button (
) to
anchor the floating image.

Step 4

Screenshot
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Crank down the opacity of the upper layer so that you can see both images.
If, they are perfectly aligned you can skip the next step. Unless you used a digital
capture on a tripod, the images probably need to be aligned. (Even if you had a film
camera on a tripod, it is difficult to get two successive scans to feed through in perfect
alignment.)
Step 5

Screenshot

Screenshot

In the Layers dialog, select the layer you need to move or rotate. In this case it is the
lower layer. Using the arrow keys, nudge the image into alignment. You may need to
rotate the image slightly too. When you get close to alignment, zoom in to get a good
close-up view and get the best possible fit.
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Step 6

Screenshot

In the Layers dialog, right-click on the upper layer and select Add Layer Mask. In the
Add Mask Options dialog, select White (Full Opacity) and click OK.
Step 7

Screenshot
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Screenshot

Now, to paint black (transparency) onto the layer mask wherever we want the lower
image to show through.
To minimize painting time, use the hand-select (“lasso”) tool to select a large, handdrawn region just inside all the borders of the area you want to paint, as shown at
right. Then using the fill tool fill the selection with black.
Step 8

Screenshot
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Screenshot

Next, select a large opaque brush from the Brushes dialog (Dialogs/Brushes), select
the Paint tool and begin painting into the mask close to the boundaries of the blend.
Notice that we still have the opacity cranked down on the upper layer so that I can see
both layers.
Step 9

Screenshot
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Screenshot

For the very edges, switch to a small, feathered brush and very carefully paint the
edges.
While painting, zoom in and out frequently (“=” key to zoom in, “-” key to zoom out)
to inspect the work. Don’t worry too much about the borders, since we’ll probably
have to touch those up anyway.
Step 10

Screenshot

Now the most painstaking part: blending the seams. This is a little tricky due to the different
tonalities of the two exposures.
For blending work, the Clone ( ), Smudge ( ), Airbrush ( ) and Blur ( ) are my tools of choice.
Since not sure if these tools have the ability to work across layers (as they do in Photoshop),
duplicate the image (Ctrl+D) and flatten the duplicate (Layers -> Flatten Image) and work on
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it. This has the additional benefit that if ever mess up the blending job too badly can always
easily start over at this step.
Note: see this tutorial on correcting blown out highlights for another example of using these
tools for blending and some useful tips on their use.
Here we have used primarily clone and a touch of smudge to blend the seams of the two
exposures.
Note: notice the chromatic aberration of the lens in the form of purple fringing at the edge of
the arch. These tools are great for dealing with that even if I were not blending two
exposures.
Final Step

Screenshot
Finished

The image still has some problems with blown out highlights in the sunlight of the
rock face. It is also a little too dark in the foreground shadow.

4.3: Creating a contrast mask
Introduction
This tutorial will show you how to do create a contrast mask for your image in
GIMP.
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Screenshot

A contrast mask allows you to reduce overall contrast, simultaneously bringing out
more detail in highlights and shadows. This may be necessary to obtain a decent print,
because prints on paper do not have as much dynamic range as a monitor; if you don’t
control the contrast, detail in the highlights may blow out and detail in the shadows
can block up and become muddy or even black. You can of course modify your
image directly in GIMP to decrease contrast, but the advantage of the contrast mask
technique is that it allows you much more precise control, and gives better results.
The basic technique is to create a layer above the image that contains a B&W
negative of the image. The images are combined in overlay mode: dark parts with
light, light parts with dark. All the while your original image remains blissfully
unchanged on its layer.
Giving credit where credit is due: I did not come up with this method. I adapted it for
GIMP from a Photoshop tutorial on The Luminous Landscape web site (great
photography web site BTW; I recommend it).
The contrast mask technique does some similar things for the exposure as the digital
split ND filter and the blended exposures techniques. If you feel your image have
exposure problems you might want to consider those techniques as well. Each one has
different strengths. Occasionally this technique gives unacceptable color shifts in
certain images. Sometimes it is just the ticket.
The Procedure
Here is the original example image, loaded into GIMP. The red leaves are a little too
dark to make out the detail; if printed, the result would be pretty dark and muddy. At
the same time, the yellow flowers have a couple of specular highlights that would
probably blow out the detail if printed.
We want to brighten the dark areas a little and darken the light areas a little. In other
words, reduce contrast.
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Step 1

Screenshot

Open the Layers dialog. Right-click on the Background layer and select Duplicate
(there is also a button for this in the bottom button bar of the Layers dialog.
Step 2

Screenshot

Screenshot

Now double-click on the duplicate layer and rename the new layer “Contrast Mask”.
(This step is not strictly necessary, but it is helpful to prevent confusion about what is
on each layer, especially if you add some additional layers for other editing
purposes).
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Step 3

Select the Contrast Mask layer. Go to the image window and right-click, selecting:
Image → Colors → Desaturate
Step 4

Screenshot

Right-click and select
Image → Colors → Invert
You now have a B&W negative image of your original. We’re going to combine this
with the original (light with dark, dark with light) to reduce the overall contrast.

Odisha State Open University, Sambalpur

67

Step 5

Screenshot

Go back to the Layers dialog and in the “Mode” drop-down box, select “Overlay”.
The result may look better in terms of contrast, but degraded in terms of overall
sharpness.
Don’t worry, we’re not done yet.
Step 6

Screenshot
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Screenshot

Go back to the image window and right click, selecting
Filters → Blur → Gaussian Blur
You will need to experiment to find the best value, but typically a value between 10
and 30 will do nicely. After blurring the contrast mask the overall image should now
look much sharper.
Click on the “eye” next to the Contrast Mask layer in the Layers dialog to rapidly
compare the image with and without the mask. Similarly, turn off the Background
layer if you want to view the mask to do further work on it.
The image at top left is the original, the top right is with the contrast mask.
Step 7

It is informative to see how this technique compares to the conventional technique of
using the contrast dialog to adjust contrast. I’ve tried to adjust the contrast to have the
leaves appear about the same. I think the image with the contrast mask has a lot more
pop! This one looks kind of flat by comparison.

Odisha State Open University, Sambalpur

69

Step 8

Screenshot

To see why this is so, compare the histograms of the images. The top one is for the
original image, the middle is for the image with the contrast mask, and the bottom
one is for the original image with the conventional contrast adjustment.
Note how the typical contrast adjustment has lost a lot of values at both ends, but the
mask technique basically preserved the entire scale.
Step 9

Screenshot

You’ll have to flatten the image if you are saving it to a typical image format like
TIFF or JPEG (but not if you are saving to GIMP’s native XCFformat). To do that,
right-click on the image and select
Layers → Flatten Image
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Fine Tuning
Now that your contrast mask is created, it’s time to fine tune it. Here are some things
you can do:

 Use the “Opacity” slider in the Layers dialog to decrease the effect of the
contrast mask overall.

 Apply Levels or Curves to the contrast mask to open up the shadows or reduce
the highlights further.

 Apply the dodge and burn tools to the contrast mask.
 Apply a layer mask to the contrast mask and use it to select only parts of the
contrast mask; e.g. if you only want the contrast mask to apply to certain areas
of the image (see my example of this below).
Tips

 See this article for some informative tests on the effects of the Gaussian Blur
step on the contrast mask.
Other Examples

Screenshot
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Screenshot

With a contrast mask as described above. Notice how the sky has recovered some
blue, and the detail visible under the tree!

Screenshot
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Screenshot

Here’s an example of how this technique overlaps with the digital split ND filter
approach. Which do you prefer?

Screenshot
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Screenshot

With a digital split ND filter. (1st image)
With a contrast mask as described above, plus a layer mask with a gradient fill, so the
contrast mask is mostly applied to the area below the cliffs. (2nd image)
Note particularly the change in the color of the cliffs and the light part of the sky just
above the cliffs, in the image using the full contrast mask (upper right). This shows
how a contrast mask affects all parts of the image, unless you selectively disable part
of the mask, as I did in the lower right. Note also that with the split nd filter (lower
left) I was able to brighten the foreground more; I could apply a general levels tweak
to the contrast mask to achieve the same thing, but it seems like more work. This
illustrates a general point for me: the digital split ND filter technique is the easier
approach when you’re already satisfied with half of the image, whereas the contrast
mask is a better starting point if the overall image needs contrast reduction on both
the dark and light sides.

4.4: Layer Masks
Layer masks are a fundamental tool in image manipulations. They allow you to
selectively modify the opacity (transparency) of the layer they belong to. This differs
from the use of the layer Opacity slider as a mask has the ability to selectively modify the
opacity of different areas across a single layer. This modification of a layer’s
transparency through a mask is non-destructive to the layer itself. This flexibility to
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define the opacity of different areas of a layer is the basis for more interesting image
manipulation techniques such as selective coloring and luminosity masking.
Adding a Mask to a Layer
Layer masks need to be added to a layer before they can be used. The process for adding
them is simple.

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Layers dialog for the image.
For this example a simple image is used with only two layers, as shown above. There
is a base image at the bottom of the stack and a single layer of teal over it. The teal
layer is the active layer (look for the white border), and the one which we will add a
layer mask to.
Right-Click on the layer you want to add a mask to (the “Teal” layer in my example),
and the Context menu will show an option to Add Layer Mask…:
Add Layer Mask in the context menu.
You can also add a layer mask through the menus:
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Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Layer → Mask → Add Layer Mask…
This will then bring up the “Add a Mask to the Layer” dialog with some options:

Screenshot

Add mask options dialog.
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There are many options for initializing the Layer Mask.
Notice that the first option is to set the entire mask to
White, which will result in full opacity on the layer (no
transparency from the mask). The option to initialize to
Black shows that the mask will make the entire layer fully
transparent.
For the purposes of this tutorial, we will let the mask
initialize to White (full opacity). You should notice a
change in your Layers dialog now that shows the layer
mask thumbnail to the right of the layer it applies to (in this case the “Teal” layer):
Layers dialog with mask applied to Teal layer.
The layer mask has now been added to the “Teal” layer. It is also active (there is a
white border around the thumbnail in the dialog, but is not visible due to the mask
being white as well) and ready for modification.
Modifying a Layers Transparency with the Mask
At this point any operations performed on the canvas will apply to the mask and not
to any layers themselves. To illustrate how masks can affect its layers transparency,
let’s paint!
Use the Rectangle Select tool to select roughly the top third of the image, and I’ll fill
this selection with black.
Tools → Selection Tools → Rectangle Select
Activating the **Rectangle Select** tool.
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Using the Rectangle Select tool, select roughly the top third of the image:
Top third of the image selected.
If you want to fill this selection with black, but before you do you need to make sure that the
foreground color is black. Click on the foreground color in the Color area to bring up the
“Change Foreground Color” dialog:
Click the foreground color to change.
The
“Change
Foreground
Color”
dialog allows you to
set the foreground
color.
For
this
example set the color
to black, RGB(0, 0,
0):
Change the color to
black.

With the foreground color set, you
can now use the Bucket Fill Tool to
fill in the selection.
Tools → Paint Tools → Bucket
Fill

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Activating the **Bucket Fill** tool.
You can now click inside the selection to fill it with the foreground color (black). As soon as
you do, you’ll be presented with a new view of your image on the canvas:
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Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

As you can see, filling the selected portion of the layer mask with black resulted in
that area having 100% transparency, showing the layer below it.
If you Rectangle select a different area of the mask, you can fill it in with a different
shade of gray to produce a variable opacity. For example, I will select a few different
regions of the mask, and fill it with different levels of gray:

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/
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If you examine the layer mask, you’ll see that there are different levels of gray being
applied (black to white, from top to bottom), and their value is what determines the
opacity of the layer.

4.5: Selective Colorization Example
A good example of the application of layer masks is doing selective colorization of an
image (selectively allowing color to show through a mostly black and white image).
Walk through how to easily do this with an image from Mardi Gras 2013:

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Start the process by duplicating the base image (Shift+Ctrl+D, or Right-Click layer
→ Duplicate Layer). From the menu:
Layer → Duplicate Layer
Then desaturate the upper layer using:
Colors → Desaturate
Following the steps above, add a layer mask to the desaturated layer and initialize it
to White (full opacity). At this point, the Layers dialog should look like this:
Screenshot
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As before, set your foreground color to black. This time, rather than filling selections,
we are going to use the Paintbrush Tool to paint areas of the image we want the color
to show through from the layer below.
I decided to paint the boy on the fence. Using the Paintbrush Tool I painted over his
shirt and head. This allowed those colors to show through from the layer below. Here
are the results after painting:

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Simple Selective Colorization Example
To illustrate what was done, here is the layer mask I
painted to achieve the above result:
Mask isolated to illustrate

Of course, you could have chosen a different color than black to create the mask. If
you wanted a slightly more muted color I could have painted with a more middle gray
vs. black:
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Simple Selective Colorization Example (painted with gray vs. black).

4.6: Basic Color Curves
Color has this amazing ability to evoke emotional responses from us. From the warm
glow of a sunny summer afternoon to a cool refreshing early evening in fall, we
associate colors with certain moods, places, feelings, and memories (consciously or
not).
Instead, we are going to take a look at the use of the Curves tool in GIMP. Even
though GIMP is used to demonstrate these ideas, the principles are generic to just
about any RGB curve adjustments.

You’re Pixels and You
First there’s something you need to consider if you haven’t before, and that’s what
goes into representing a colored pixel on your screen.

Title-Basic Color Curves
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Basic_Color_Curves/

Open up an image in GIMP.Now zoom in.
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Nope - don’t be shy now,zoom in more! And there’s Nope - don’t be shy now, zoom
in more! And there’s your pixel. So let’s investigate what goes into making your
pixel.
Remember, each pixel is represented by a combination of 3 colors: Red, Green, and
Blue. In GIMP (currently at 8-bit), that means that each RGB color can have a value
from 0 - 255, and combining these three colors with varying levels in each channel
will result in all the colors you can see in your image.
If all three channels have a value of 255 - then the resulting color will be pure white.
If all three channels have a value of 0 - then the resulting color will be pure black.
If all three channels have the same value, then you will get a shade of gray
(128,128,128 would be a middle graycolor for instance).
So now let’s see what goes into making up your pixel:
The RGB components that mix into your final blue pixel.
As you can see, there is more blue than
anything else (it is a bluish pixel after
all), followed by green, then a dash of
red. If we were to change the values of
each channel, but kept ratio the same
between Red, Green, and Blue, then we
would keep the same color and just
lighten or darken the pixel by some
amount.

Curves: Value
So let’s leave your pixel alone for the time being, and actually have a look at the
Curves dialog. I’ll be using this wonderful image by Eric from Flickr.
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Title-Curves Value
Attribution- Qsimple
Source- flickr.com
Link- https://www.gimp.org/tutorials/Basic_Color_Curves/

Opening up my Curves dialog shows me the following:
Colors → Curves…
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We can see that I start off with the curve
for the Value of the pixels. I could also use
the drop down for “Channel” to change to
red, green or blue curves if I wanted to.
For now let’s look at Value, though.
In the main area of the dialog I am
presented with a linear curve, behind
which I will see a histogram of the value
data for the entire image (showing the
amount of each value across my image).
Notice a spike in the high values on the
right, and a small gap at the brightest
values.
What we can do right now is to adjust the
values of each pixel in the image using this
curve. The best way to visualize it is to
remember that the bottom range from
black to white represents the current
value of the pixels, and the left range is
the value to be mapped to.
So to show an example of how this
curve will affect your image, suppose I
wanted to remap all the values in the
image that were in the midtones, and to
make them all lighter. I can do this by
clicking on the curve near the midtones,
and dragging the curve higher in the Y
direction:

Screenshot
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Screenshot
What this curve does is takes the values around the midtones, and pushes their values
to be much lighter than they were. In this case, values around 128 were re-mapped to
now be closer to 192.
Because the curve is set Smooth, there will be a gradual transition for all the tones
surrounding my point to be pulled in the same direction (this makes for a smoother
fall-off as opposed to an abrupt change at one value). Because there is only a single
point in the curve right now, this means that all values will be pulled higher.
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The
results
of
pushing
the
midtones of the value curve higher (compare to original).
Care should be taken when fiddling with these curves to not blow things out or
destroy detail, of course. We only push the curves here to illustrate what they do.
A very common curve adjustment you may hear about is to apply a slight “S” curve
to your values. The effect of this curve would be to darken the dark tones, and to
lighten the light tones - in effect increasing global contrast on your image.
For instance, if I click on another point in the curves, and adjust the points to form a
shape like so:
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A slight “S” curve
This will now cause dark values to become even darker, while the light values get a
small boost. The curve still passes through the midpoint, so middle tones will stay
closer to what they were.

Slight “S” curve increases global contrast (click for original).
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In general, it easiest to visualize in terms of which regions in the curve will affect
different tones in your image. Here is a quick way to visualize it (that is true for value
as well as RGB curves):
If there is one thing you take away from
reading this, let it be the image above.
Curves: Colors
So how does this apply to other channels?
Let’s have a look.
The exact same theory applies in the RGB
channels as it did with values. The relative
positions of the darks, midtones, and lights
are still the same in the curve dialog. The
primary difference now is that you can
control the contribution of color in specific
tonal regions of your image.
Value, Red, Green, Blue channel picker.
You choose which channel you want to
adjust from the “Channel” drop-down.
To begin demonstrating what happens here
it helps to have an idea of generally what
effect you would like to apply to your image. This is often the hardest part of
adjusting the color tones if you don’t have a clear idea to start with.
For example, perhaps we wanted to
“cool” down the shadows of our
image.
“Cool”
shadows
are
commonly seen during the day in
shadows out of direct sunlight. The
light that does fall in shadows is
mostly reflected light from a bluish
sky, so the shadows will trend
slightly more blue.
To try this, let’s adjust the Blue
channel to be a little more prominent
in the darker tones of our image, but
to get back to normal around the
midtones and lighter.
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Screenshot
Boosting blues in darker tones
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Screenshot

Now, here’s a question: If you wanted to “cool” the darker tones with more blue,
what if you wanted to “warm” the lighter tones by adding a little yellow?
Well, there’s no “Yellow” curve to modify, so how to approach that? Have a look at
this HSV color wheel below:
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Screenshot

The thing to look out for here is that opposite your blue tones on this wheel, you’ll
find yellow. In fact, for each of the Red, Green, and Blue channels, the opposite
colors on the color wheel will show you what an absence of that color will do to your
image. So remember:
Red → Cyan
Green → Magenta
Blue → Yellow
What this means to you while manipulating curves is that if you drag a curve for blue
up, you will boost the blue in that region of your image. If instead you drag the curve
for blue down, you will be removing blues (or boosting the Yellows in that region of
your image).
So to boost the blues in the dark tones, but
increase the yellow in the lighter tones, you
could create a sort of “reverse” S-curve in the
blue channel:
Screenshot
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Screenshot

Boost blues in darks, boost yellow in high tones
In the green channel for instance, you can begin to introduce more magenta into the
tones by decreasing the curve. So dropping the green curve in the dark tones, and
letting it settle back to normal towards the high tones will produce results like this:
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Screenshot

Screenshot

Suppressing the green channel in darks/mids adds a bit of magenta
(click for original).
In isolation, these curves are fun to play with, but think that perhaps walking through
some actual examples of color toning/grading would help to illustrate what we are
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talking about here. Choose a couple of common toning examples to show what
happens when you begin mixing all three channels up.

4.7: Check Your Progress
1. What are the three different types of color channel?

----------------------------------------------------------------------------------------------------------------------------------------------------------------------2. What is Layer masks In GIMP? Give example.

----------------------------------------------------------------------------------------------------------------------------------------------------------------------3. How to select a photograph and adjust the colour toning & gradient of that
photograph using GIMP?

-----------------------------------------------------------------------------------------------------------------------------------------------------------------------

Readings:

The Photography Book by Editors of Phaidon Press, 30 April 2000.
All about Photography by Ashok Dilwali, National Book trust, Year of
Publication:2010 New Delhi.
Practical photography by O.P. SHARMA HPB/FC (14 March 2003.
The Photographer's Guide to Light by Freeman John Collins & Brown, 2005.
Lonely Planet's Best Ever Photography Tips by Richard I'Anson published by Lonely
Planet
Suggested Readings:
Camera Lucida: Reflections on Photography- Roland BarthesOn Photography- Susan Sontag
The Man, The Image & The World: A Retrospective- Henri Cartier-Bresson
Basic Photography- Michael Langford.
All about Photography by Ashok Dilwali, National Book trust , Year of Publication:2010
New Delhi.
Practical photography by O.P. SHARMA HPB/FC (14 March 2003.
The Photographer's Guide to Light by Freeman John Collins & Brown, 2005.
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